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Kurzweil 3000 Version 16 for Windows 

Overview 

Kurzweil 3000 software program offers integrated features that promote and aid students in Reading, 

Studying, and Writing. Based on Universal Design for Learning principles, it provides users with multiple 

ways to access information and curriculum, and with tools to help them accomplish tasks independently, 

practice active learning skills and demonstrate acquired knowledge. 

The following quick start guide has been adapted from the original product user guides from Kurzweil 

3000, available from the following website link: 

Website for Kuzweil 3000 Product Guilde (https://www.kurzweiledu.com/products/product-

guides.html)  
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To Use 

Opening and Closing Kurzweil 3000 

To start Kurzweil 3000 double-click the Kurzweil 3000 icon on the desktop or in the AT Software Folder. 

https://www.kurzweiledu.com/products/product-guides.html
https://www.kurzweiledu.com/products/product-guides.html
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Note: you will always need to log on with your username and password. 

To stop Kurzweil 3000 do one of the following: 

• From the File menu, choose Exit. 

• Or click Close. 

• Or press ATL+F+X. 

How it is organized 

The Kurzweil 3000 Window 

The Kurzweil home screen includes the main menu, access to the toolbars for reading, writing, and 

scanning, as well as options for opening new and existing files, and scanning new documents.  

 

The Main Menu 

 

The Main Menu toolbar is used to: 

• Manage documents  
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o new, open, save, extract, send to, print, and create audio files 

• Edit the document  

• Open scanning options  

• Change reading options  

o reading speed, mode, unit, and language  

• Change viewing options  

o fit to, zoom, rotate pate, thumbnails, page view, view annotations 

• Access tools 

o highlights, notes, spell check, and pronunciations 

• Access reference tools 

o definitions, synonyms, syllables, pictures, and select a dictionary 

• Search online 

o search for books, magazines, and translations 

• Seek for help 

Toolbars 

There are three default toolbars on Kurzweil 3000 that provide access to the Reading, Writing, and 

Scanning features of Kurzweil.  

 

How to Navigate Kurzweil 3000 Toolbars 

The Reading Toolbar 

 

When the reading toolbar is selected, the navigation menu allows users to: 

• Save documents 

• Navigate to the previous and next page 

• Insert bookmarks 

• Zoom in and out of the page 

• View thumbnails of other documents opened 

• Print documents  
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To the right of the toolbar tabs are the controls for the basic reading features of Kurzweil 3000. 

 

The basic reading features include: 

• Play 

• Go back one unit of reading 

• Go forward one unit of reading 

• Control for silent reading or text-to-speech 

o This feature allows users to choose whether the program speaks the text out lout as it is 

highlighted.  

When a document is open in the Reading Toolbar, additional features will be available on the left side of 

the screen. This panel is called the Study Skills Toolbar.  

 

On the Study Skills toolbar, users have the options to: 

• Open existing documents by clicking on the folder icon  

• Use annotation features by clicking on the highlighter icon  

o 6 highlighting colors 
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o 2 circling color options 

o Strike through options 

• Use the eraser feature to delete highlights, circling, and strike through by clicking on the eraser 

icon  

• Add a text note by clicking on the A icon  

• Insert hyperlinks by clicking the double chain icon  

• Insert a sticky note by clicking on the sticky note icon  

• Insert a voice note by clicking on the person speaking icon  

• Insert footnote by clicking on the footnote icon  

• Close out of a footnote by clicking on the X icon  

• Delete current note by clicking on the trashcan icon  

• Insert column notes by clicking on the page icon  

• Complete a spell check by clicking on the ABC check mark icon  

• Get definition of selected word by clicking on the magnifier on a book icon  

• Get pictures of a selected word by clicking on the picture icon  

Highlight Features  

• To highlight, select the text to highlight or circle, then click the desired color highlighter in the 

Study Skills toolbar, or click the color Highlighter or Circle tool first then select the text. 

• To erase highlights, select the text that has color highlighting, then click the Eraser icon in the 

Study Skills toolbar.  

• To find highlighted text, open the Edit menu, select Find, select Object, select Highlight, click 

Find. 
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• To collect highlights or notes from a document and organize them into a separate KESI file, 

select File, Extract, and Extract Notes and Highlights. When prompted, select checkboxes of the 

notes, bookmarks, and highlight colors you wish to extract  

 

Column Note Options 

Use the page icon in the Study Skills toolbar to utilize this note taking feature  

Based on the Cornell note taking system, Kurzweil 3000 Column Notes is ideal for taking notes while 

reading and doing research and reviewing/studying notes. 
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The default Column Notes file opens at the bottom of the Kurzweil 3000 document window and 

contains a table with three columns: Main Ideas, Supporting Ideas, and Other. 

 

Highlights can be extracted to column notes with the following process:  

1. In a document, use the Color Highlighter tools from the Study Skills toolbar. Highlight the 

different types and levels of information you want to collect. For example: Yellow highlighter for 

main ideas, Green for supporting ideas, and Blue for details. Click the Column Notes button or 

select Column Notes from the Study Skills toolbar. 

2. In the Open Column Notes dialog, select either to create a Blank Column Notes file or to open 

an Existing Column Notes file. 

3. From the File menu, choose Extract, then Extract Highlights to Column Notes. 

 
 

4. Specify the column number to which you want the text of a particular color highlight to fill: 

Column 1, 2 or 3. Other numbers are not valid. 

5. Click OK 
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Note: Other options to extract highlights are available such as Extract Highlights to Column Notes, 

Extract Text, and Extract Highlights to Vocabulary Study Guide.   

Audio Options  

Kurzweil provides users with options to customize their audio settings to control how the program 

provides text-to-speech.  

 

The dropdown menu under Audio Options allows users to: 
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• Adjust how quickly the program reads text aloud which is measured in words per minute 

 
• Change the voice by selecting different voices from the dropdown menu  

•  
• Adjust the Reading Mode between continuous, self-paced, and word by word 

 
• Adjust the Reading Unit between a word, phrase, line, sentence, paragraph, heading, or 

highlight  

• Change the Language between English, Spanish, Portuguese and French.  

The Writing Toolbar 

The Writing toolbar looks very similar to the Reading tool with a few additions. The Writing toolbar can 

be accessed by clicking on the Write tab. 

 

 The writing toolbar includes options to: 

• View your document 

o Brainstorm 

o Outline 

o Split Screen 

o Draft View 

 

• Adjust your font type, font size, and page layout 

 

• Create a Bibliography for your document  
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Writing Basics  

To open a new document, click on the New Document icon and select between a new Draft, 

Brainstorm, or Outline. 

 

New Draft  

• When writing a New Draft, the Kurzweil writing environment is similar to other word processing 

programs for changing font style and basic page formatting. Select the New Draft option and 

write just as if operating in a Word File. 

New Brainstorm  

• When writing a Brainstorm, the default Brainstorm window opens with the work area 

containing a single "Thought" in the Oval shape, as a starting point for your diagram. A floating 

tools palette appears 

 
• The tools palette contains the following tools: 

o Quick takes  

▪ This tool allows users to create a subtopic 

▪ First click on the topic you want to create a subtopic from, then click the Quick 

Takes button to add your subtopic 

o Link tool  

▪ This tool allows users to create connections between topics 

▪ First click on the topic you would like to link from, then click to Link button to 

add a link to a different topic or subtopic  

o Arrange tool  

▪ This tool allows users to organize topics into a hierarchical order 

o Note tool  

▪ This tool allows users to create a side note 

▪ When the side note is created, click on the page icon that will appear on the top 

right corner of you topic to show or hide your side note 
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o Options to select different shapes of brainstorm ideas  

▪ Shapes include Oval, Rectangle, Rounded Rectangle, and Diamond 

o Fill color tool  

▪ This tool allows users to fill in their brain storm bubbles with different colors 

▪ Select brain storm bubble, then click on fill color button and select a color 

o Background color tool  

▪ This tool allows users to change the color of the brainstorm screen 

o Text color tool  

▪ This tool allows users to change the color of the text for the brainstorm idea 

▪ Select brain storm bubble, then click on text color button and select a color 

o Default tool  

▪ This tool allows users to revert back to default settings 

o Delete tool  

▪ This too allows users to delete an idea 

• At any point in the process of writing a brainstorm, it is possible to toggle through viewing the 

document in an Outline  or Split Screen  format which contains notes as well as 

the outline. 

• The Outline format presents the information from the brainstorm in a linear fashion and 

provides the following tools to organize the outline: 

 
o Add topic  

o Add Subtopic 

o Move to the Left/Promote 

o Move to the Right/Demote 

o Move Up 

o Move Down 

o Insert a Note 

o Delete a topic 

o Prefix label to select the bulleting format  

o Create a Draft when finished with the outline  
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Writing Tools  

In addition to the annotation features mentioned previously, the writing menu includes a Review 

Writing tool that walks users through how to proof their writing and Word Completion which predicts 

what word the user is typing. 

 

The Scanning Toolbar  

Scanning a Document 

To scan documents into a KEZI file: 

1. Make sure your scanner or document camera is turned on. Select the Scanner Set up button 

and follow the prompts.  

 
 

2. Place the material to be scanned on the scanner glass (or under the document camera). 

3. Click the Scan button on the scanning toolbar.  
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4. When the scan is complete the page image appears in the Kurzweil 3000 document area. Each 

new page you scan is added to the end of the document. 

5. A document undergoes optical character recognition (OCR) whenever scanned or printed to 

Kurzweil which provides the user with a document that can be read aloud to them with text to 

speech and allows users to highlight, annotate, and use copy & paste commands.   

 

Documents can be further edited using the following 3 features: 

 
• Zone Editor  

o This tool allows users to change the reading order of the scanned document. 

• Edit Underlying 

o This tool allows users to edit the text of the scanned document. 

• Header/Footer 

o This tool allows users to insert and edit the headers and footers of the scanned 

document  

Scanning Tools 

The Scanning Toolbar contains options to:  
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• Rescan page   

• Insert page  

• Preview the page  

o This option allows users to see the page prior to scanning it 

• Insert an image  

• Scan in color  

• Double sided scanning  

• Two-page-mode  

• Repeated scanning  

o This option allows users to automatically scan the next page after every 14 seconds 

• Edit the underlying text  

• Spell check  
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• Re-recognize the page  

o This option allows users to rescan the page for optical character recognition (OCR) 

• Delete the page  

Using Basic Kurzweil Features  

Opening a document  

Users can work with virtually any kind of document in Kurzweil 3000. 

• Image document that users scan into Kurzweil 3000 

• Document that users open from another application 

• Document that users opened using the KESI Virtual Printer 

• Text documents 

To open a document, users can: 

1. Select the Open button  in the Main Menu of the Reading Toolbar. 

2. Users will be able to open through three different options 

 
a. Open from a Local Computer, Universal Library, or Google Drive 

3. In the Open dialog, users can navigate to open the desired file on the computer. To ensure that 

a document maintains its layout, users may want to follow the KESI virtual printer option below.  

Using the KESI Virtual Printer for file formats not supported by Kurzweil 3000 

To open documents that do not have a file format supported by Kurzweil 3000 you can use the KESI 

virtual printer. To do this you must have the application that can open the file and that application must 

have the Print function. You must also have the latest version of Adobe Acrobat Reader. 

1. Open the document. 

2. In the program’s Print Setup or Print dialog, select KESI Virtual Printer. 
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3. Choose Print. Kurzweil 3000 launches and displays the image document. 

4. Note: To reproduce a document in color when using the KESI Virtual Printer select color in the 

print setup menu.  

Saving a Document 

The default setting for saving a document is as a .kes file. Saving a file as a .kes ensures that all 

annotations (highlights, notes, brainstorms etc.) are preserved. Documents can be saved as several file 

types; however this does not ensure annotation preservations. To save:  

1. Click the save button in the reading toolbar  

2. Select location on your computer to save document as a (.kes) file.  

3. You will be prompted to save documents including column notes, outlines, etc. upon closing 

them with the x in the upper right hand corner of the dialogue box.  

Navigating within a Document  

• Use the Page buttons in the Reading toolbar to go to a page 

 
o Click the Page box, and type the page number you want to go to. 

o Or click the Previous/Next arrow to move page by page. 
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• Use the Thumbnail buttons in the Reading toolbar to scroll in a document or to go to a  

o Click the Thumbnail View button to display thumbnail views of the pages in the 

document. Click the thumbnail of the page you want to go to. 

• Use keyboard keys to go to the Next, Previous or specified 

o Next page: press CTRL+E. 

o Previous page: press CTRL+ R. 

o Go to page: press CTRL+G. 

• Use the bookmarks ** insert photo of reading toolbar with red box around bookmarks 

o Click where in the document you wish to add a bookmark then select Add/Go To 

Bookmarks, when prompted select Add. 

o To navigate to bookmarks, select Add/Go to Bookmarks and select the desired 

bookmark. Bookmarks can be organized alphabetically or in the order that they appear 

in the document. 

Visual Reading Settings  

Customize the highlighting colors and backgrounds to optimize the reading experience. 
 
To change the highlighting colors: 

1. From the Tools menu, select Options. 
2. Click the Text button to open the Text Options pane. 
3. In the Colors area, specify the desired colors for the word and sentence highlighting. 
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Reference Tools  

The following tools in the reference menu can be helpful while reading: 

• Look up a word’s Definition, find a Synonym, see and hear a word’s Syllables, see a Picture of a 

word, and hear the Pronunciation of a word.  

 

Basic Settings  

To change other settings in Kurzweil 3000 including general, reading, text, image, magnifier, 

highlighters, spell check, work prediction, review items, scanning, and key mapping utilize the 

following pathway.  

1. Click on tools from the main tool bar. Select options from the dropdown.  
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2. Navigate the setting options by utilizing the icons on the left hand side of the dialogue box.  

 
3. All settings will be saved to your user profile.  

Accessing E-Textbooks/ EPUB 

• Log in to the software version of Kurzweil and go to “Open Existing File.” Choose the location of 

the EPUB file you want to open. 

• Save the EPUB file as a kesi file and reopen. 

 Available features:  

• Text-to-speech with highlighting 

• Voice selection & speed adjustment 

• Highlighting  

• Voice notes 

• Bookmarking 

• Dictionary 

• Picture dictionary  

• Add/edit hyperlink 

• Add a footnote 

• Open column note 

Concerns: 
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• Larger files may freeze 

• Extract highlights was very buggy 

• No thumbnail view 

Additional Features  

Additional Help  

For additional help, users can click Help on the Main Menu Toolbar for additional tutorials for 

customizing, setting up, and utilizing advanced features of Kurzweil 3000 

Kurzweil 3000 Online  

Kurzweil 3000 has online features such as a Kurzweil 3000 Online Account and reading website. To find 

out more information, check out Kurzweil 3000 Online Quick Start Guide.  

Program Manufacturer Contact Info 

• Cambium Learning Technologies 

• Phone Number: 800-894-5374; Outside the United States and Canada: +1-508-315-6600 

• Website: Kurzweil 3000 Website (https://www.kurzweiledu.com/default.html)  

• Cost: $500 for a one year subscription 

o Students registered with the ATRC may be able to use Kurzweil 3000 software on their 

personal computers through our site license while they are students at CSU 

https://www.kurzweiledu.com/default.html



